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Welcome to ProjectDox .Before using the ProjectDox System for the first time please verify the

following items are disabled and/or installed on your system. The following pages will provide you
information on how to configure these items for access to collaborate and review your information
electronically 24 X 7.

® Pop-up Blocker Disabled (if applicable)

® ProjectDox Components Installed
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POP-UP BLOCKER (IE)

ProjectDox uses pop-up windows (browser windows with no toolbars). If you log in, but no ProjectDox
window appears, or a warning is received, you probably have a pop-up blocker that is preventing the
main project window from opening. You need to allow ALL pop-ups for the ProjectDox site. You can do
this in one of two ways:

1. Disable pop-up blockers entirely
2. Configure blocker to allow pop-ups for specified sites

The following instructions will allow pop-ups from the ProjectDox site within Internet Explorer. If after
configuring the pop-up blocker in IE, you still receive the warning message from the ProjectDox
application, verify your system has no other pop-up blockers installed. For instance, if the Google
Search bar is installed, it contains its own pop-up blocker that will need to be disabled. In some cases,
anti-virus software can cause similar behavior. If you verify all pop-up blockers are disabled and you
continue to have issues check your system anti-virus logs to see if that software may be blocking the site
from displaying. If the anti-virus is blocking the installation, add the necessary exceptions.

CONFIGURE POP-UP BLOCKERIIN IE

1. Navigate to Internet Options for your version of Internet Explorer (IE). Instructions below

are based on IE9.
=NRCN X
a. Select the Gears icon seen in blue. —_— l \ ! J
\
1

b. Select Internet Options ‘ - & N
Print >
File »
Zoom (100% 3
Safety »
View downloads Ctrl+)

Manage add-ons
F12 developer tools

Go to pinned sites

Internet options

About Internet Explorer

2. Click the Privacy Tab to set-up an exception for the ProjectDox site.

-

Internet Cpticns ? %

| General | Security | Privacy |Cnntent | Connections | Programs | Aduanr_ed|




System Use Requirements

a. Click the Settings button

Pop-up Blocker
| Turn on Pop-up Blodker | Settings
InPrivate

b. Inthe Pop-Up Blocker Settings Window, enter the ProjectDox site URL.

Pop-up Blocker Settings [ﬁ,l

Exceptions
D Pop-ups are cumently blocked. You can allow pop-ups from specific
=1

websites by adding the site to the list below.

Address of website to allow:

hitps://yourProject DoxSite U R L com./Project Do Add

c. Click the Add button
d. Click to Close the Pop-up Blocker Settings window.
e. Click the OK button for the Internet Option window.

PROJECTDOX COMPONENT INSTALLATION
ProjectDox requires the installation of ActiveX controls to be able to perform certain actions: Uploading
Files, Downloading Files, Viewing Files, and Viewing Help Information. There are two ways users can

install the controls:

1. The link to an MSl file for installing the ActiveX controls is available from the login screen.

To oreate a desktop shorteut, dick and

5 ﬁ icon below to your desktop. Click here to add ProjectDox Training
% to your Favorites.

my
A

2. If permissions for the PC allow ActiveX download and installation, the user may elect to install
the components for the four respective actions the first time each is performed.

If using the MSI from the login page, the user can accept the defaults to run the MSI and install the
controls. If not using the MSI, then after logging in to the site, the user will be prompted by the browser
to install the ActiveX control (yellow bar at top of the screen or at the bottom of the screen depending
on system version) when attempting to perform any of the above actions. If the user’s network requires
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Administrative access to download ActiveX controls, the user will NOT be prompted nor will the MSI on
the login screen install. The user will need to contact their network administrator to get access to
download these controls.

Before installing the components, verify the items below. Instructions are provided in
the following sections on how to add the site as Trusted, and how to temporarily disable UAC.

1. Add ProjectDox site as a Trusted Site
2. Disable UAC (Vista and Windows7 users only)
3. Recommend Admin/Power User Rights to PC for proper installation
4. Verify System Requirements for Silverlight Control.
ADD AS TRUSTED SITE
1. Click on the Tools menu in Internet Explorer and select Internet Options
= | &
w
Print |
File >
Zoom (100%) »
Safety >
View downloads Ctrl+)

Manage add-ons
F12 developer tools

Go to pinned sites

Internet options

About Internet Explorer

2. Inthe Internet Options dialog box, click the Security tab

3. Inthe Security tab, click the Trusted Sites icon and then the Sites... button

Internet Options ¥ 2%

|
J| | General | Security |Privacy I Content I Connections I Programs IAdvancedl

Select a zone to view or change security settings.

@ & v 0O

Internet  Localintranet Trusted sites  Restricted
sites

Internet

Sites
@ This zone is for Internet websites, -
except those listed in trusted and
restricted zones.
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4, Type in the main URL for the site you are trying to view, for example:

Trusted sites ﬁ

‘}'P You can add and remove websites from this zone. All websites in
e 4 this zone will use the zone's security settings.

Add this website to the zone:
https:/ourProjectDoxSite. com/ProjectDoy Add

Websites:

http: /feplantest. springfieldmao. gov
http: //suppartpartal infograph. com
https://173.251.49. 162

https: /fapps.rackspace.com

L e U U

)

m| »

1

[| Require server verification (https:) for &l sites in this zone

Close

5. Click the Add button to add the site to the list.
6. Click the Close button to close the Trusted Sites dialog.

7. Click OK to close the Internet Options window.

DISABLE UAC (User Account Control)

Disabling of the UAC control should be discussed with your network administrator prior to making
changes to your system if applicable. In all cases, after the installation is complete and each of the
actions have been performed once (uploading files, viewing files, downloading files, and viewing help,
as applicable) the UAC control can be returned to the former setting.

1. From the Control Panel, open User Accounts.

r|3!, ¥ Control Panel » User Accounts » User Accounts
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Click the “Turn User Account Control on or off” (Vista) or “Change User Account Control
Settings” (Windows7) link.

Update the UAC by following the below:

e VISTA: In the “Turn on User Account Control (UAC) to make your computer more
secure” options screen, clear the checkbox for “Use User Account Control (UAC) to help
protect your computer”.

e WINDOWS?7: Click and drag the slide control to “Never Notify”.

Fy) User Account Contraol Settings = OB £

Choose when to be natified about changes to your computer

User Account Control helps prevent potentially harmful programs from making changes to
your computer,
Tell me more about User Account Control settings

Always notify

Never notify me when:

® Programs try to install software or make changes
to my computer

® [make changes to Windows settings

ﬂ MNet recommended. Choose this only if you need
to use pregrams that are not certified for
Windows 7 because they do not support User
- - Account Contral.

MNever netify

[ H OK ]| Cancel

Click “OK” and restart the system.
Note: The system must be restarted for the UAC changes to take effect.

Note: The User's permissions level/rights will affect how the UAC works.

Note: After successful installation and one time usage of the ProjectDox Components, the
system’s UAC control can be returned to the former setting. A reboot will be required for the
change to take effect.
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INSTALLATION OF SILVERLIGHT (Batch and Drag —n-Drop Upload Capabilities)

ProjectDox provides a default upload component with no additional installation required. It is limited to
five (5) file uploads selecting a single file for each row. An example of this default component is seen
below and accessed when the Upload Files button is selected from a folder.

Batch upload capability, along with the “Drag-n-Drop” feature for uploading, is available with the
installation of the Silverlight Control. The below instructions will walk the user through installation and
list the system requirements.

(2 Planroom - Windows Internet Explarer =& 2

JE} https:/s fActiveXUpload.aspx?FolderID=1 & E.

I ' O

Upload files:{Drag-n-drop available for Silverlight only}) Metadata (Appliedto all uploaded files)

[Clinherit metadata for versioned files * Required field

File Type:* _______ -

Erowse...
Erowse...
Browse...

Erowse...

Browse...

ResetFields | [ Upload

To use the enhanced upload tool, including drag and drop, please download the Silverlight
application framewaork. Install Silverlight Mow

Upload URL:

URL Display Name:

URL:

Upload URL

1. Verify your system requirements

e Make sure you are running a Silverlight-compatible operating system and browser, and that

you have uninstalled any previous version of Silverlight.
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UNIVERSITY

For Windows Internet Explorer users:

Browsers Supported:

Windows
Vista
Windows XP
SP2, SP3
Windows
2000 SP4 +
KB 891861

For Macintosh users:
If you are installing Silverlight on a Macintosh system, the following requirements must be met:

e Silverlight versions after 1.0 run only on Intel processor based Macintosh (not PCC processor)
e  Minimum Intel Core Due 1.83-gigahertz (GHz) or higher processor with 512-MB of RAM

Mac System requirements for Silverlight 5

Silverlight 5

Silverlight 4

2. Click the link “Install Silverlight Now” to download and install. Download also available able at:
http://www.microsoft.com/getsilverlight/Get-Started/Install/Default.aspx

10


http://www.microsoft.com/getsilverlight/Get-Started/Install/Default.aspx

UN VERSITY

Upload files:{Drag-n-drop available for Silverlight only)

Browse. ..

Browse. ..

Bro
Bro

Reset Fields || Upload

To use the enhanced upload tool, including dra
application framewaork. [nstall Silverlight Mow

ease download the Silverlight

Upload URL:

URL Display Hame:

URL:

Upload URL

For Mozilla Firefox users:
e Save Silverlight.exe control to your hard disk.
e Once the download is finished, click Open.

e The installation starts.

3. If prompted, the user may click to Save the Silverlight.exe to their desktop, or click Run to install the
component without saving and download to their system.

4. Click 'Install now' after reviewing the license agreement and privacy statement.

System Use Requirements
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UNIVERSITY

Install Silverlight

By dlicking Install now you accept the Silverlight
license agreement.

\View the Silverlight License Agreement

Microsoft® Siverkght updates automatically,

You can now use Silverlight.

@ - Windows Internet Explorer == = |
X a g

Close Window

Upload files:(Drag-n-drop available for Silverlight only) Metadata (Appliedto all uploaded files)
Inherit metadata for versioned files * Required field

File Type: *

-

Installation successful

You may have to refresh (F5) the
Web page for these changes to take

Microsoft® effect.

Silverlight

Upload URL:

URL Display Name:

URL:

12
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INSTALLATION OF VIEWER COMPONENT (IE)

If not installing from the login page, and using the prompts when opening a file for the first time, the
below screen will display with a white background instead of the selected file.

e Look for the ActiveX tool bar at the top or bottom (Depends on operating system) of the page.
e Click Allow to allow the installation of the BravaClientX Module.

§ pian layoutl.dwg - Windows Intemet Explorer — E’:ﬁ
4\5 https mumnv ew.gwinnettcounty.com. t t & Gwinnett County [US] &

e wants to run the following add-on: ‘BravaClientX Module' from
raphics Corp. (unverified publisher) Allow |~

e After successful installation, the file can be selected again to be viewed.

@ plan layout1dwg - Windows Internet Explorer s E]. | S|
@ nttps://eddsplanreview.gwinnettcounty.com/projectdox/ActiveXViewer aspxiFilelD=59 E|
FAsB @ LOo22 -Haaali|e G - -

=3 2| Model

13



System Use Requirements

COMPONENT TROUBLESHOOTING

The following section reviews common issues with the installation of the components, along with
recommendations for resolution. Most issues are related to lack of permissions to install the required
components on the PC, or the enabling of the UAC during the installation process.

UNABLE TO BATCH UPLOAD
ISSUE:

Unable to upload more than a single file at a time to the upload files box.

:? Planrocom - Windows Internet Explarer =

(0

J a https:/ [ActiveXUpload.aspx?FolderID=1

Upload files:(Drag-n-drop available for Silverlight only) Metadata (Appliedto all uploaded files)

[Clinherit metadata for versioned files * Required fie

File Type:* -

Browse...
Browse...
Browse...

Browse...

Browse...

ResetFields | [ Upload

To use the enhanced upload tool, including drag and drop, please download the Silverlight
application framework. |nstall Silverlight MNow

Id

Upload URL:

URL Display Name:

URL:
RESOLUTION STEPS

e Install the Silverlight Control to allow for batch and drag-n-drop upload. The installer
can be obtained from the link “Install Silverlight Now".

14
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TY

UNIVERS

Successfully installed Silverlight control will provide a screen like the one below (metadata section is

optional, depending on project configuration):
=

i

[+l e2

Windows Internet Explarer

Close Window

Metadata (Applied to all uploaded files)
* Required field

Upload files:{Drag-n-drop available for Silverlight only)
Selected Files: [l inherit metadata for versioned files
File Type:* -

Upload URL:

URL Display Name:

URL:

15
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FILE VIEWING ISSUE

Issue:
User selects to view a file or view a markup on a file. A blank white window or a blank white window

with a small box in the upper left window appears.

Click on a file and a white
window opens. Many
times, it has a small window
in the left corner.

RESOLUTION STEPS

First Time User:

e If running Vista or Windows 7, verify that UAC is disabled. If UAC was enabled during the
installation, disable UAC (including the reboot), uninstall the components, and delete the IGC
folder from your profile before re-installing.

e Verify the ProjectDox site is in your list of “Trusted Sites”.

e |Ifissues persist, increase the permissions for the user account on the PC to Admin/Power User
Rights. This should allow the components to download.

Return User:

e Ifinstalling updated components as a result of a ProjectDox upgrade ensure that the former
Components have been uninstalled by uninstalling the ProjectDox Components from the
Control Panel.

o Delete from your profile the contents of the IGC folder C:\
Users\YourProfileName\[x6_0 or x7_0]
= X6_0is for ProjectDox versions 7.2-7.5
= X70_is for the ProjectDox Versions 7.7

16
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== x4
@\\ S0« 16C » 60 « |43 | [ Searchx - p
Organize v Includeinlibrary v Sharewith v Bum  » -~ B3 @
Bl Desktop A

& Downloads .
| BCXView.ini

%, BravaClientX.dll
¥ BravaWebhelp.chm

Recent Places

a Libraries
- %, GDIPlusGate.dll
*| Documents
N %, Integration_6.0.59.dll
") sic L
s B 5 msvepTL.dil
=/ Pictures
H vid ) msver7ldll
fideos

search_macros.xml

version.tet
* Homegroup

"% Computer
& os(c)
- Backup (E)

9 items

e If running Vista or Windows7, verify that UAC is disabled. If UAC was enabled during the

installation, disable UAC (including reboot), then uninstall the components, and delete the IGC
folder from your profile before re-installing.

e Verify the ProjectDox site is in your list of “Trusted Sites”.

If issues persist, increase the permissions for the user account on the PC to Admin/Power User
Rights. This should allow the components to download.

Once the components are successfully installed when a file is selected for viewing, it should appear with
the image in the new window or in the frame of the application.

@ plan layoutldwg - Windows Intemet Explorer p—_—= (S | S|
d?, hitps://eddsplanreview.gwinnettcounty.com/ projectdox/ActiveXViewer.aspx?FillD=59 3|
FUHsB kD2 -@raqlil@ Gy ~ -

WEER| | uoder ‘ n

17



